
Anagram Genius Demo Help

Welcome to Anagram Genius, the software that was recently described by the London 
Evening Standard as "Mindblowingly extraordinary", by The Daily Telegraph as 
"Tremendous fun" and which has also been favourably covered by much of the rest of the
United Kingdom's press, radio and television!

This demo version gives you the opportunity to see what all the fuss is about. It is not 
completely up to Anagram Genius's full anagram-crunching abilities in that it contains a
lexicon that is less half the normal size and will only let you do ten runs before a specific 
date (see the README file) before refusing to do anymore. However, it will give you a good 
flavour of the capabilities of the program and allow you to see what truth lurks within the 
letters of your name, employer's name and the names of a few friends. If you like what you 
see you can easily purchase the full program for the bargain price of £19.99 !

Click here for details of how to order the full version        Click here for more information 
about this demo
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This anagram was, of course, created using Anagram Genius!



Quick Start 

For those of you desperate to sample the program without having to read through all the 
documentation, the minimum that you can get away with is:

Type in your full name. Click on Male if you are male or Female if you are female. (If 
your name has a very strange balance of letters you should also switch off the Score ? or 
better control). You may also want to select Satire or Flattery mode depending on your 
personality!

Click on the big Weed button.

When the search is over scan through the found anagrams and double click on any 
that are good. Select a word order and finally save or print a report of the best anagrams 
using the 

 or 
 buttons. 

This will give you a quick taste of the program. To learn more see Overview of Anagram 
Genius followed by the stages in detail starting with The Input Stage. When you are fully 
familiar with the program you should read the Tips section. 

If you are unfamiliar with the concept of an anagram you should also read Overview of 
Multi-Word Anagrams.



This stands for Artificial Intelligence which is the branch of Computer Science concerned 
with endowing machines with human-like intelligence.



Overview of Multi-Word Anagrams

Most of us have a basic understanding of what an anagram is. We may have seen them in 
crosswords where a handful of letters are rearranged to form a single English word. The 
most sophisticated anagram any of us may have come across will probably be one of the 
classics such as "Punishment"="Nine thumps" which were discovered generations ago by
dedicated geniuses playing with pen and paper. We are unlikely, however, to have come 
across anagrams of phrases of any length and even less likely are we to have come across 
beautiful multi-word anagrams of our own names or of those close to us. To do so requires 
talent, lots of luck and enormous amounts of time spent sitting with pen, paper and a 
dictionary or it requires a computer running sophisticated computer software. Using 
computers to find anagrams is not a new idea but only one computer program has the speed
and sophistication to make producing long beautiful anagrams viable: Anagram Genius.

Anagram Genius produces multi-word anagrams and tries to make them relevant to the
text being anagrammed. The results instead of drab single words can be beautiful 
definitions: "Indomitableness"="Endless ambition" or stinging political satire: "Ronald 
Wilson Reagan"="A long-insane Warlord", "The Conservative Party"="Teacher in 
vast poverty" (for non-British readers the British Conservative party has been frequently 
in dispute with Teachers' unions over pay levels). They can even be the answer to 
philosophical questions: "The meaning of life"="The fine game of nil". (For more 
examples see Example Anagrams)

The rule about multi-word anagrams is that they must be perfect. No shortfall or extra 
letters are allowed no matter how excellent the resulting anagram. Addition of punctuation,
however, is legitimate.

Other programs have attempted to do this in the past simply by outputing all collections of 
English words which make up the letters. Nearly all of these make no sense at all and are 
completely irrelevant to the initial text (e.g. "The Conservative Party"="CARRY-ON THETA 
STEVE VIP"). Moreover all but the shortest searches can take literally years of computer 
time to complete. Thus such programs are only effective for very short initial texts and for 
people with enormous patience.

Anagram Genius is a quantum leap in multi-word anagram generators in that it 
individually scores each anagram it finds and will only keep the best five hundred (or 
whatever you choose) for you to browse. Innovative AI techniques are used to make good 
guesses and keep the ones that are statistically the most likely to be relevant and 
meaningful.

Moreover, an extremely fast search algorithm enables this process to be done in a very 
short period of time. It enables long pieces of text to be searched completely and small or 
medium length texts can be searched in just a few seconds. A search could take months or 
years of computer time without this level of sophistication and as a result Anagram 
Genius can be used on names and phrases that have never been anagrammed before.

For an overview of the operation of the program see Overview of Anagram Genius.





Click here to proceed to The Weed Stage.



Click here to proceed to The Search Stage.



Click here to proceed to The Word Stage.



When not in the Input stage, this button will take you back to the Input Stage.



Enter the text that you want to form anagrams of here. Feel free to use mixed case and 
punctuation.



The Input Stage
For the main list of help topics available go the Contents page.
For an extremely brief 'hands-on' first run with the program see Quick Start.
For an overview of how to use the program see Overview of Anagram Genius.
For details of the Input Stage keep reading...

The Input Stage is where you tell the program about the run that you want to do:

The first thing is to enter the text that you want to anagram. This can be a person or 
business's name or any piece of English text. Feel free to use punctuation and upper or 
lower case. Only the letters are looked at.

You then set the flags. These flags tell the program a little about the text (and so results in 
more relevant anagrams). They also describe how the run should be done.

Description
The top flags describe the anagram text.
Male, Female and Inanimate give the gender of the anagram text.

Satire, Flattery and Normal say what kind of emphasis you are trying to get.

Finally the three option switches Political, Business and Computer give extra information 
about the text. 

Dictionary
This section of the input window controls the dictionary scan.

The flags are:
Dropped 'H' words,    Interjections,    Shuffle Bonus    and Vulgar Words

There is also a choice between American English or British English.

Search
The final section controls the anagram search.

You can control the length of the run: Maximum minutes; the minimum score: Score ? or 
better; how many anagrams are kept: Maximum anagrams and even the maximum number
of words in the anagrams: Maximum Words



Male
Click on the male flag if the text is a man.



Female
Click on the female flag if the text is a woman.



Inanimate
Click on the inanimate flag if the text is an inanimate object such as a business or 
institution.



Satire
Click on satire if you want an emphasis towards derogatory anagrams.



Flattery
Click on flattery if you want an emphasis towards flattering anagrams.



Normal
Click on normal if you want the anagrams to have no particular good/bad emphasis (other 
than that which already exists in the English language).



Political
Set this flag if the anagram text is a politician or political party.



Business
Set this flag if the text is a business or someone closely associated with a business.



Computer
Set this flag if the text is computer related. i.e. the name of a computer company, software 
package etc.



Dropped 'H' words
This causes the inclusion of words from the dictionary that normally have a starting 'H' but 
where the 'H' is dropped and replaced by an apostrophe. e.g. 'ello, 'orrible etc. Switch this 
flag off if you do not want these words to be used.



Interjections
This flags controls how frequently interjections such as "Wow!", "Oh my!" etc. are used in 
anagrams. These words are very useful for anagram formation as their presence does not 
affect the grammatical context of anything that follows. However, they do reduce the 
'purity' of the anagram. Switching this flag off will greatly reduce the amount that they are 
used.



Shuffle Bonus
This option indicates that words should be penalised for not being a good mix of the initial 
text. If the flag is off some of the anagrams found will be very similar to the initial text or 
even the initial text itself! For example the word "Business" would be penalised for use in 
anagrams of "International Business Machines" with this flag set.



Vulgar Words
This allows or censors coarse or offensive words and phrases. When combined with the 
Satire flag these words are considered highly desirable!



Maximum Minutes
This controls the amount of time that the program has to run when searching for anagrams.
If the program senses that it is going to overrun this schedule it adjusts itself to run faster. 
By doing this it runs a risk of losing some anagrams. The more time pressure the program 
is put under the more risks it takes. If anagrams are lost an asterisk (*) will be displayed in 
the Schedule field of the Search window at the end of the run and a message to that effect 
will be written into the report. 

If you switch the schedule flag off the number of minutes in the box is ignored and no 
schedule is set.



Score ? or better
Every anagram is assigned a percentage 'score'. The lower the percentage the less likely 
the anagram is to make sense and be relevant to the initial text. Only the highest scoring 
anagrams are kept but you can speed the search up by setting a higher minimum at the 
start using this option. By default it is set to 40% but for some unusual texts you may wish 
to lower this limit or set the limit off. 



Maximum Anagrams
This option allows you say how many anagrams you want to keep. By default the best 500 
are kept. If you are doing a comprehensive search you may wish to raise this number, for a 
quick fast search you may wish to lower it. The less anagrams that are kept the faster the 
search.

It is not generally a good idea to switch this option off unless the anagram text is very 
short. Some phrases can have literally millions of anagrams and your machine's memory 
will be swamped. This is especially a problem if you also switch off the Score ? or better 
option.



Maximum Words
This controls the maximum words that are used in the anagram. When set only anagrams 
less than or equal to the specified length will be kept. For most applications leave this off.



American English
When this flag is set British spellings and other non-standard American words will be 
penalised. This should be the default when the country code indicates the United States.



British English
When this flag is set American spellings, words and phrases will be penalised for use in 
anagrams.



The Word Stage
During the word stage the lexicon is scanned to find subwords. In addition to finding them 
to also scores them according to a complicated algorithm based on their utility for forming 
meaningful anagrams and their relevance to the initial text. There are seven possible 
scores: Superb, Ideal, Excellent, Good, Average, Poor and Terrible. All but Superb are
assigned by the computer. The Superb category is left for hand-scoring only. A window at 
the sides counts the various categories of subword. Only the program's categorisations are 
shown in this window. 

As the program is not human and knows only a little about the initial text this automatic 
scoring is not perfect. For this reason you have the opportunity at this stage to override the
computer's score for any word.

To do this double click on the word. A dialogue box will then open allowing you to select a 
new category. 

If you change the word's score it will be coloured red in the window from them on so that 
you can tell which words you have changed. If your initial text has some rare letters in it 
beware of giving too good a score to a short subword which contains those rare letters: This
will result in that subword dominating the found anagrams.

For an overview of how the program works and the other stages see Overview of Anagram 
Genius.



Subwords
These are words composed only from the letters in the text. e.g. if you are anagramming 
"Genius" the words "Sign" and "Using" are subwords but "Big" is not because there is no 
"B" in "Genius" and "Gene" is not because "Genius" only has one "e".

Multi-word anagrams must be composed exclusively of these words.



The Search Stage
This the stage where the program searches for the anagrams. For an overview of the 
operation of all the program see Overview of Anagram Genius.

Just before it starts the anagram search it precompiles information about the subwords that
enables this search to go very fast. The time it spends precompiling can vary from a 
fraction of a second to a few minutes depending on how many subwords there are. A 
percentage figure shows how much of the operation has been completed.

When the search is running the found anagrams are shown in a window at the top and 
various information is continuously displayed in the bottom window. Only one permutation 
of the word-order for each anagram is generated. The word-order displayed is chosen to 
maximise the chances of the anagram making sense but it is often wrong. You have a 
chance to choose a better word-order during The Weed Stage.

Best, Worst and Average are the best, worst and average (mean) percentage scores of 
the anagrams stored. When the required number of anagrams have been found, newer 
better anagrams push the worse ones out so the worst and average scores will rise from 
that point onwards.

Time is the number of seconds of computer time consumed so far by the search. With 
other programs running or with other simultaneous anagram searches going on at the 
same time, this will run slower than real time.

End is a rolling estimate of the total amount of computer time it will take to finish the 
search. The estimate can be very inaccurate but gives some idea.

Schedule shows whether the search is running behind of ahead of the schedule specified 
in the input screen. If an asterisk (*) is displayed this shows that the program's attempts to 
get within the schedule have resulted in some anagrams being lost compared with what 
the situation would be if no schedule had been set. Sometimes the program manages to 
catch up again and the asterisk disappears. If an asterisk is present at the end of the 
search (and thus anagrams have been permanently lost) a message to that effect will be 
put in any report generated.

Stored shows the number of anagrams kept. This starts at zero and when it reaches the 
number specified in the Input screen it stops. Found shows the total number of anagrams 
that have ever been stored including those that were stored initially and then pushed out 
when better anagrams were discovered.

Done shows the percentage of the search that has been completed.

The bar at the bottom shows a sequence of snapshots of the search. During an anagram 
search hundreds of millions of word combinations will be tried at lightning speed in order to
find good anagrams. The words currently being looking at when the window is updated are 
printed out there.



The Weed Stage
For details of how the stages fit together see Overview of Anagram Genius.
For details of this stage, keep reading...

During this stage the found anagrams are displayed in a bigger window than they were 
during the search allowing you to see more of them simultaneously. When you double click 
on an anagram a window opens allowing you to select the word order:

Select the words in the order that you want, using the mouse, add punctuation and other 
changes if necessary and then click OK. Redo sends you back to the start of the process 
and Cancel closes the window without storing the anagram.

Just after you click OK a second check is made to ensure that what you have edited is still 
an anagram of the initial text. If it is not, an error will be reported and the anagram will not 
be stored. Sometimes it is not only desirable to add punctuation but also (for example) to 
move an 'S' from the end of one word to the end of another. This check means that you can
do some more adventurous editing without having to worry about errors finding their way 
into the report.

The weeded anagrams appear in the top window. If you later want to remove or edit one of 
these anagrams double click on it and a dialogue box will open allowing you to do so.

Tip
If the word-order and punctuation in the bigger window is exactly how you want it anyway 
you can save time by simply double-clicking with the RIGHT mouse button on the anagram.
This sends the anagram directly to the weeded list.



Alternative Anagrams
Anagrams need not just be converting somebody or something's name. Here are some 
alternative forms of anagrams you can experiment with:

Answers to questions: e.g. Question: "Is pity love?", Answer: "Positively!". 
Question: "Will you marry me?"; Answer: "O my! well I'm... 'urray!!" (this last one is a 
good example of bringing an anagram to life with creative punctuation!)

Word definitions: e.g. Word: "Capitalism"; Definition: "I am plastic"; Word: 
"Indomitableness"; Definition: "Endless ambition".

Anagrams in different forms: e.g. Can you find an English phrase which is typed 
using only the top row of the keyboard, each key being pressed once and only once? i.e. 
What is an anagram of "QWERTYUIOP"? "Quip, yet row".

Anagrams with extra or unusual significance: e.g. "Eleven plus two"="Twelve
plus one". 



Tips
Although the program does most of the work in finding good anagrams, a skilled user can 
improve its chances. Here are a few tips for getting the most out of the program.

The scope for good anagrams is very dependent on the balance of letters in the 
anagram text. Texts containing 'J's, 'Z's and 'Q's will generate anagrams of lower scores and 
the subwords containing those rare letters will become disproportionately more important 
than those that do not. Try to avoid texts with a strange balance of letters and if you do hand
edit the subwords that contain the rare letters to make sure that they are right. Strange 
letter balances can often be avoided when you have a choice of what the text can be. For 
example if your name is Michael John Ryan you should do much better anagramming 
"Michael Ryan" than "Michael J. Ryan" or "Michael John Ryan" - try it and see!

Hand editing of subwords is time-consuming but worthwhile. It is amazing how often 
a careful check of the scan will reveal an amazingly relevant word which through the 
ignorance of the program about the text is not scored highly enough. Generally speaking it is
more important to find good words which have not been scored highly enough than to spend
time reducing the value of irrelevant words that have been scored too well though both 
methods will have some benefit. One case where reducing the value of an irrelevant word 
will have significant benefit is when you find that it is dominating the anagrams, perhaps 
because it mops up all the rare letters and has a good score. If you see this happening, flick 
back to the word stage, change its score and start the search again.

Try and choose initial texts that you know lots about. If you choose such a subject the
chances of finding relevant anagrams are greatly increased. If you only know one thing 
about the text you are unlikely to be able to say that in an anagram.

If you do not succeed the first time, try again. For most anagram texts there are 
variants that you can try. For most people there are first name variants (Robert->Bob->Rob 
etc.), middle-names and initials that can be inserted or left out and/or titles/qualifications 
("Mister", "MA", "Doctor" etc.) that can be added on or left off. For businesses there are 
appendages such as "Inc", "Ltd", "Corp" etc.

If you discover after the run that the worst kept score is high (e.g. >75%) you might 
want to repeat the run keeping more anagrams.

If you find any truly excellent anagrams please send them in to us. See We want your 
anagrams!



A List Box is a common control that you see in Windows applications. It allows the user to 
view and possibly select an item from a list. The Word and Search stages have a single 
listbox visible. In the Weed stage there are two.



Troubleshooting
I have done an anagram run but I cannot find any good anagrams. Input texts

vary enormously in their scope for being anagrammed. However there are many things you 
can do to increase your chances even with the most difficult texts. For more information see 
Tips.

I have typed in the initial text, the search is over but there are no 
anagrams in the window. This happens only rarely when the text is unusual. It is possible 
that there are some anagrams but they score less than the minimum. Go back to the Input 
Stage by pressing the big Input button; switch off the Score ? or Better flag and then repeat 
the search by pressing the big Weed button. If you still do not have any anagrams or the flag
was already switched off your Input Text is very strange: Replace it with a variant of the text 
and try again.

I have typed in the Input Text and the dictionary scan is complete but 
before the search can begin a message has appeared telling me that no anagrams
are possible. This happens if there is a letter in your initial text that does not appear in any
subword. As a result no anagrams are possible as that letter can never be used. This 
happens remarkably rarely and is an indication that your input is extremely unusual: Try 
again with a variation on the text.

I still have some runs left but the program says that the demonstration 
period has expired. In addition to the limit of ten runs there is also a date when this demo 
expires. This date should be in the README file and you must conclude your evaluation 
beforehand.

The computer has ground to a halt during an anagram search. This occurs in 
all Windows applications when the computer starts to run out of memory. When you type in 
a long Input Text the memory used to store all the subwords and the anagrams may swamp 
the machine, especially if you do not have much RAM installed in your PC or if you switch off 
the limit to the number of kept anagrams so the computer is trying to store many thousands
of them. The solution is to Quit any other applications that are running to free up memory 
and/or try again with a shorter input text. If you have set the number of anagrams to keep 
very high (the Maximum ? Anagrams control in the Input Stage) or switched the limit off 
completely you should switch it on and set it to a sensible value (e.g. 500). Switching off the 
Dropped 'H' flag before repeating the search will also help a little.

The number of subwords/stored anagrams is very big and the list I can see 
is incomplete. This is a problem with Windows. Windows version 3.1 only allows an 
absolute maximum of 8160 items to be displayed in a List Box. The subwords/anagrams that
you cannot see are still stored by the program so the subwords will be used in anagram 
formation and the extra anagrams will appear if you save or print them but they cannot be 
edited or viewed. Future versions of Windows may correct this limitation.

The same anagram appears twice in the list. This happens very rarely when 
there is a multiple 'word' such as "I am a" appearing in a high scoring anagram. Lower down 
the same anagram may appear with the constituent words appearing individually. Checking 
for this would be too time-consuming to make it worthwhile so the current version of 
Anagram Genius does not do it.. Future versions may address the issue of multiple-word 
'words' in a more sophisticated way.

I am clicking the stage buttons but the software is not doing anything. You 
have probably paused the window. Unpause it by selecting Continue from the File menu.



When I try to open a new anagram window the computer bleeps/gives me 
an error and immediately closes it again. This happens when the system resources run 
low and there is not space for certain resources that each anagram window needs. The 
program will usually explain in an error box but if the total system resources are very low 
even that may not be possible and it will bleep instead. This usually happens when you have
opened six or seven windows but may happen earlier if you have other programs running 
which are using memory. (In exceptional situations it may even happen when the program 
starts up and an attempt is made to open the first window.) The solution is to close some 
other anagram windows and/or close other applications. Unfortunately the space that 
Windows uses for this is separate from main memory so having lots of RAM will not help. 
Future versions of Windows will almost certainly get around this problem.

Printing does not work with my printer/I have not yet configured my printer
for Windows. Anagram Genius has been tested with many types of printers but there are 
many thousands of types and it is impractical to test them all. If your printer works reliably 
with other Windows applications please send us a note with the type of printer and 
name/version of the printer driver so we can compile a list and hopefully get around the 
problem in future. In the meantime you can save out the data as ASCII text and print it out 
at your leisure from another application or even from DOS if you can print reliably from 
there. 

If your problem is not listed here and you are considering contacting us about it please read
the section on Technical Support.



Overview of Anagram Genius
The process of finding multi-word anagrams is divided up into four stages:

The first stage, The Input Stage, is where the user specifies the text that they want 
anagramming and describes the nature of the text to the program so that the AI routines 
can do a good job of making the anagrams relevant.

The software contains a lexicon of English words which it uses to form anagrams. In 
this dictionary are many words which could not ever be part of an anagram of the text 
supplied. This is because they contain letters which are not in the anagram text. The second 
of these stages, therefore, is involved in the process of extracting from the lexicon only the 
words which are subwords of the initial text. During this stage the user can also tell the 
program in detail about the relevance of these individual words. This stage is called The 
Word Stage.

The next stage is the actual anagram search. The program uses a very powerful 
search algorithm to try to find combinations of these subwords which form meaningful, 
relevant anagrams and stores what it considers to be the best ones. This stage is called The 
Search Stage.

Despite the sophistication of the program there will still be many examples which do 
not make sense and are not relevant to the initial text. The final stage is where the user 
does a little gardening, weeding out the poor anagrams and preserving the flowers. This 
stage is called The Weed Stage and also enables the user to select the best word-order and 
add extra punctuation. When this stage is finished the best anagrams can be printed out or 
saved in the form of a report.

Moving between these four stages is controlled by the four big buttons at the top of each 
window. There is one button for each stage. Pressing these buttons is exactly the same as 
selecting the appropriate stage from the Stage menu.

When a button is pressed the program proceeds to the end of that stage doing as much 
work as necessary to get there. For example, if you enter some text and the click on the 
Weed button, the program will do the entire process of scanning the lexicon and searching 
for anagrams and then stop at the Weed stage. When you have got there you can then 
move around the stages instantly as no extra work needs doing. Make a serious change at 
the Input stage and the scan or search may need re-doing so you will have to wait once 
more.

Anagram Genius uses the multi-document interface enabling you to do a number of 
anagram runs simultaneously. These will multi-task between themselves as well as with any
other applications running simultaneously under Windows.

For an overview of multi-word anagrams see Overview of Multi-Word Anagrams.



Thanks to Donald L. Holmes for this anagram. (Naturally he used Anagram Genius to 
find it.)
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The ToolBar

The ToolBar provides a quick way to produce some of the menu commands. To get help on 
the effect on a button, simply click on it now.



This opens a new anagram window. It is equivalent to the New command from the File 
menu.



This pauses processing on the current window. The window will stay frozen until you 
unpause it again. It is equivalent to the Pause command on the File menu.



This sets a window calculating again after it has been paused. It is equivalent to the 
Continue command from the File menu.



This button turns the cursor into a different kind of arrow. When you then point and click 
with it will give you specific help on whatever it was that you pointed to. It is particularly 
useful for the Input Stage where you can use it to identify the purpose of each control.



This opens a window containing brief information about the software including the version 
number and copyright details. It is equivalent to the About Anagram Genius command 
from the Help menu.



This saves out the report as text to a file. It is exactly equivalent to the Report command 
from the Save menu. It is only available from the Weed stage.



This sends the report to the printer. It is exactly the same as the Report=>Print command
from the Print menu.



Menu Commands

Anagram Genius follows Microsoft style guidelines so many of the menu commands 
(such as the contents of the Window menu) are exactly the same both in format and 
meaning as other good Windows software. The commands that are different are described 
here:

The File Menu
Pause temporarily halts processing for the current window. You may wish to do this to give 
more computer time to another window or to another multi-tasking application. Additionally
after certain serious errors Anagram Genius may pause a window for you. 

When a window has been paused the Continue command is enabled. This resumes 
processing exactly where the run left off.

Find Subword allows you to search for a subword when in the Word Stage. It opens a 
dialogue box allowing you to type the subword in and if it exists it will highlight it when you 
press OK and scroll the window to its position.

Abort Search winds up the search very quickly (usually within fifteen seconds). Doing this 
will miss many good anagrams and it is not advised. The search can be temporarily 
stopped by going back to a previous stage such as Input.

The Stage Menu
This menu is identical in effect to the four big buttons on each anagram run. Selecting a 
stage will move the run to the end of that stage doing as much work as necessary to get 
there. For more information see Overview of Anagram Genius.

The Save Menu
This menu enables you to save out three things from your anagram run. The first is a list of 
subwords, the second is the raw unweeded anagrams and the third is a report based on the
anagrams that you selected in The Weed Stage which gives some other information as well 
such as the longest subwords found. All the files are saved as ASCII text.

Save Input Options saves the current settings of the input screen as the default. This can
save you some time if your most commonly used settings are different from the ones that 
the program suggests. 

The Print Menu
This is very similar to the Save menu except that instead of the data being saved it is sent 
to the printer. So that you see what it is going to look like before wasting paper each menu 
command has a Preview option which enables you to see an exact representation of the 
print-out on the screen beforehand.



ASCII Text
For people who have not come across this term before, ASCII text is a very basic format for 
storing text. It can be imported by almost all wordprocessing packages. Files containing it 
usually have the file extension '.TXT'.



We want your anagrams!

We have a collection of thousands of excellent anagrams created with Anagram Genius 
and are hoping to produce a book. However we can always use more excellent anagrams if 
you find them.

If you have found one or more truly excellent anagrams using this software please share 
them with us and other users of the program by sending them in. The address is:

Genius 2000 Software
P.O. Box 395
Cambridge CB3 9PJ
United Kingdom

They can also be sent by email: AGenius@genius.demon.co.uk
By doing this you certify that the anagrams are your own discovery and give us permission 
to use them in this publication and in other ways for the promotion of the software.

In return, if we use your anagrams, we shall send you a free copy of the first edition of the 
publication where it appears and will also acknowledge you by name. (If, for some reason 
you do not want your name to appear, please mention that when you submit the 
anagrams).



Technical Support
Technical Support is not really available to owners of the Demonstration version. However 
comments and queries can be made in writing to our development office:

Genius 2000 Software
PO Box 395
Cambridge CB3 9PJ
UK

or by email to: AGenius@genius.demon.co.uk
Under no circumstances are we able to offer technical support on the telephone.

Click here for details on how to order the full version of Anagram Genius.



United States Ordering
We are currently looking for a United States distributor. In the meantime, we can ship the 
product by fast airmail from the United Kingdom with only minimal inconvenience.

The price from the US is only 19.99 pounds sterling plus 3.65 shipping and handling 
(£23.64).

With a credit card you can order readily by telephoning 011 44 151 356 8000. It be sure 
to catch British office hours you will need to phone in the early morning on a week day (The
UK is 5 or 6 hours later than EST).

Credit card orders will result in your card being debited in US dollars at the prevailing 
exchange rate.

Alternatively you can fax your details to: 011 44 151 357 2813. Please include your credit
card number and expiry date, a contact telephone number, name and delivery address and
address as known to the credit card company if different.

Credit card details or a check can also be mailed to our sales office:

Genius 2000 Software
PO Box 2
Ellesmere Port
South Wirral L65 3EA
United Kingdom

The cost of an airmail letter from the US to the UK is 50 cents (write "Airmail" on the 
envelope.)

Checks should either be drawn in pounds sterling on a British bank or as normal in US 
dollars in which case a further two pounds sterling should be added before converting to 
cover bank charges (most newspapers carry daily    exchange rates: 20 pounds is roughly 
30 dollars). All checks should be payable to "Genius 2000 Software"

Orders are sent by fast airmail.



Ordering from Outside the UK
If ordering from the United States, click here.

The cost of the software is only 19.99 + 3.65 pounds sterling (totalling 23.64).

With a credit card you can order easily by telephoning +44 151 356 8000 with the details 
during United Kingdom office hours (Monday to Friday 9am to 5pm).

Alternatively you can fax your credit card details to: +44 151 357 2813. Include your card
number and expiry date, a contact telephone number, the name and delivery address and 
the address as known to the credit card company if different.

The order can also be sent to our sales office:

Genius 2000 Software
PO Box 2
Ellesmere Port
South Wirral L65 3EA
United Kingdom

You can pay by credit card or cheque. Cheques (payable to "Genius 2000 Software") should 
be drawn in pounds sterling on a British bank. Alternatively you can send a local cheque if 
you live in Western Europe, Canada, Australia or New Zealand. Add an extra 5 pounds 
sterling to cover bank charges and convert to your local currency (most newspapers carry 
daily exchange rates). If it is easier for you, you can send a cheque in US dollars drawn on a
US bank with a 2 pound banking charge.

All orders are shipped by air.



Anagram Genius Order form (PCDirect)

Select Print Topic from the File menu of your help viewer and fill this in. If you don't have 
a printer then simply follow the instructions in Ordering information.
Please send _____ copies @ only £19.99 per copy.                  Total: ____________

Shipping and Handling is £1.65 within UK or £3.65 overseas.              ____________

Grand total                                                              ____________

If paying by credit card please give number: ______________________________ Expiry ____/____

My daytime telephone number is: ________________________

Please deliver to:

Name: ______________________________________

Address: ___________________________________

         ___________________________________

         ___________________________________

If these details are different from those known by the credit card company please enter those 
details here:

Name: ______________________________________

Address: ___________________________________

         ___________________________________

         ___________________________________

Signed: ______________________   Date: _______________

Alternatively I enclose a cheque payable to "Genius 2000 Software".

Please send this form to Genius 2000 Software, PO Box 2, Ellesmere Port, South 
Wirral L65 3EA, UK

If paying by credit card it can also be faxed to: 0151 357 2813 (+44 151 357 2813)

or the details can be read out on the phone to: 0151 356 8000

Cheques should be in pounds sterling payable on a British bank. Overseas cheques are also
acceptable, add 2 pounds sterling for US checks or 5 pounds sterling otherwise to cover 
bank charges before converting to your local currency.



How to Order

Ordering Anagram Genius is easy. Click here if ordering from outside the United 
Kingdom.

The price is only £19.99 + £1.65 shipping and handling (total: £21.64).

Pick up the telephone and dial 0151 356 8000 with your credit card details ready.

Send a cheque to our sales office: Genius 2000 Software, PO Box 2, Ellesmere 
Port, South Wirral L65 3EA.

Fax your credit card details to 0151 357 2813. Include your credit card number and 
expiry date, daytime telephone number, name and delivery address and address as known 
to the credit card company if different.

Click here for an order form



The Full Version
For ordering details click here            For an order form click here

This is a demonstration version of Anagram Genius. It is limited in the following ways:

Its lexicon size is only 35 000 words. The full version of Anagram Genius knows 
about over twice as many words (80 000) and therefore has the potential to find many 
better anagrams.

This demo will refuse to run after a certain date or if it has completed more than ten 
complete anagram searches. With the full version you can run the software forever and as 
many times as you like.

Some of the features, such as being able to save out the subwords and raw anagrams
are missing from this demonstration version. They are present in the full version. You also 
get printed documentation.

Another advantage of ordering is that you become a registered owner of the software. This 
means that you will be kept up-to-date with and given discounts on future versions, have 
access to technical support and have all the other advantages of being one of our 
customers.

The full version of Anagram Genius costs only £19.99 !!

For ordering details click here            For an order form click here



UK Political Satire
These can result from combining the Politics flag with Satire mode.

"The Conservative Party"="Teacher in vast poverty."
"The Labour Party"="A prole? Bury that!"/"Upbeat Harlotry."
"Scottish National Party"="Oh nasty tartan politics."

"Michael Portillo"="A cool, limp Hitler."
"Virginia Bottomley"="I'm an evil Tory bigot."
"Virginia Bottomley, Health Secretary"="I am the totally overbearing hysteric."
"William Waldegrave"="Veal? Wield a grim law."

"Anthony Charles Lynton Blair"="Tyrannic rant all boloney: Shh!"/"Nonchalantly 
is abhorrently."
"Anthony Blair, Labour Leader"="Dire, banally-honourable rat."

"Margaret Hilda Thatcher"="A girl; the arch mad hatter."/"Ha! The large rich mad
tart."/"High-tech Armada rattler."

"The Reverend Ian Paisley"="I, rather insanely peeved."



Miscellaneous British Anagrams

"Richard Charles Nicholas Branson"="Scorns darn hellish or anarchic BA."/"Darn 
cool rich rash banal richness."

"Bruce Forsyth's Generation Game"="Embarrassing ego of the Century."

"The National Lottery"="Oh entertain totally."

"Advertising Standards Authority"="Distrust dashing narrative today."

"Camilla Parker Bowles"="Workable caramel lips."/"I'm Palace balls worker."
"His Royal Highness, The Prince of Wales"="Sly harsh English poser - I cheat on 
wife."



World Leaders
"President William Clinton"="Nice limp wild total sinner."

"President Boris Yeltsin"="Tipsiness done terribly."/"Endless insobriety 
trip."/"One isn't terribly pissed."

"Ronald Wilson Reagan"="A long-insane Warlord."



Computer-related anagrams
Having the Computer flag on helps with these. Business helps with the companies.

"Microsoft Incorporated"="Profit-coercion stardom."
"Microsoft Windows"="I'd wow conformists."
"Apple Macintosh"="Laptop machines."
"Acorn Computers"="Crap on customer."/"Crap to consumer."

"Anagram Genius for Windows"="Gain amusing word of answer."/"Massage now 
unfair wording."



Miscellaneous Anagrams
"The best things in life are free."="Nail-biting refreshes the feet!"
(It is free after all! However you might need to pay for some yoga lessons first!)

"The end of the world is nigh!"="Down this hole frightened."
"The meaning of life."="The fine game of nil."

"William Shakespeare"="I am a weakish speller."



Very Vulgar Anagrams
We shall let you discover these for yourself! Set the Satire and Vulgar words flags and try
a few names. "President Boris Yeltsin" is a major source of such (extremely unjustified) 
anagrams.



Example Anagrams
These are a few random examples of the kind of anagrams that can be easily generated 
with Anagram Genius. They constitute a tiny tiny percentage of the total decent 
anagrams collected over the years of development of this software. The full collection will 
eventually form the basis of a book (see We want your anagrams)
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